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Agenda

* Threat Modeling ¢ Browser & Search
* Network Segmentation + Small Business

* PC Lockdown * Training & Events
* E-mail * Random Tips

* VPN

= USB

« AV

Staying secure in today's hyperconnected digital society requires more than
anti-virus and software updates. This presentation will offer practical advice for
**individuals**, **homes**, and **small businesses** with **actionable** steps to
be more secure against current threats. Trendy buzzwords covered include:
OPSEC, OSINT, privacy, PIl, 2FA/MFA, |oT, Wi-Fi, Tor, VPN, and more (with plenty of
lulz thrown in for good measure). The focus will be on free (or low cost) software
and services, and operational security procedures that will enhance your ability
to navigate an increasingly hostile digital landscape.
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THREAT MODELING

* Threat modeling —The first step

© HIEHID > HEAY

(if you know your enemies and know yourself, you will
not be imperiled)

- Sun Tzu,Art of War

Security Plan — Answer these five questions

* What do | want to protect?

* Who do | want to protect it from?

* How bad are the consequences if | fail?

* How likely is it that | will need to protect it?

* How much trouble am | willing to go through to try to prevent potential consequences?

* Source: https://ssd.eff.org/en/module/your-security-plan
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Source: https://ssd.eff.org/en/module/your-security-plan

Common things worth protecting

* Family photos

* Trade secrets

= Business continuity
* Money

* Your kids

* Your privacy (location for one; stalkers & dictators)

NETWORK
SEGMENTATION
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Typically reserved for companies with an IT budget, or high-end tech users that
grok RFC. But there’s an easier option already on your network, and it’s easy to
configure.

Network segmentation

* What: Put all your untrusted devices on a separate isolated VLAN segment...the easy way via
Guest Network on your wireless router.

* Big win; small cost
* Guests can only talk to the Internet

* Guests can't
* Talk to the router
* Talk to each other

» Con: not appropriate for devices that need to talk to others (NAS, TV controlled via mobile
app)

Guests can’t

» Talk to the router — most routers have security issues, so it is best if network

guests can’t connect at al

* Talk to each other -
“Guest network” isolation is not to be confused with a similar feature that might
be offered on your main network called ‘AP isolation’ or “wireless isolation”.
But that means none of your devices can talk to each other, nor can they reach
wired device (such as printers). It's probably best to use the Guest Network
feature and put untrusted and one-way devices there.
You can use a simple network scanner app, such as Fing, on your mobile device
to test that your guest network is isolating each connected device.
Lock Down Your Wi-Fi Network With Your Router’s Wireless Isolation Option —
https://www.howtogeek.com/179089/lock-down-your-wi-fi-network-with-your-
routers-wireless-isolation-option/
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Network segmentation - Wikipedia —
https://en.wikipedia.org/wiki/Network_segmentation

TRUST BUT VERIFY — SELF-AUDIT
YOUR GUEST NETWORK

Acme Internet

4 devices of 8

* Use a simple, free, mobile app to inventory from

standard vs. guest network [ ol hone

* Fing App — https://www.fing.com/products/fing-app/ g Archer Ciovs

 Ecin's Macbook Air

a Family Sonos

PC Lockdown

No admin access for the ones you love. #TuffLove
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The best thing you can do for those in your (cyber) care is to disable their ability
to destroy their own computer by mistake.
In Microsoft Windows this means removing

STANDARD USER

[ User Account Control Settings

Werifed publishes: Mo Winaws

* If the PC only needs one account then create

two:

* Admin one for periodic use (i.e. remote support

person)

* Standard (non-admin) one for the actual user
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E-MAIL

E-mail headers leaking your IP address

* |P address ~ real-time geolocation of sender

* But wait, there’s more: may include your internal IP address
* Facilitates cross-site request forgery (CSRF) against internal devices

= Sept 16, 2019: SOHOpelessly Broken 2.0 — by Independent Security Evaluators —

https://www.securityevaluators.com/whitepaper/sohopelessly-broken-2/

* Summary: 13 of 13 of the devices = remote access to the device's shell or administrative panel.
* 12 of 13 allowed complete control over the device (6 without authentication);

* 5 had CSRF vulnerabilities

© Maven Security Consulting Inc. 8lPage
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Summary: 13 of 13 of the devices (SOHO router and NAS devices) had
vulnerability that allowed remote access to the device’s shell or device’s
administrative panel.

12 of 13 of the devices allowed complete control over the device (6 without
authentication);

5 had CSRF. Knowing the internal IP scheme - if changed from the default —is
super helpful during the attack..thanks e-mail headers!

Self-Audit E-mail for IP leaks

* Determine if you are giving up your
* External IP address (~ real-time geolocation)

* Internal IP address

» Self-Audit: Email Leak Tests — http://emailipleak.com/
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E-mail Security Checklist

* Disable auto-accept of calendar invites

* Gmail - http:/bit.ly/350Lw9Y
* Outlook - http:/bit.ly/34Q 1 Gmn

» Consider e-mail with better security & privacy options [Top 5]

* Proton Mail https://protonmail.com/security-details

+ CounterMail, Hushmail, Mailfence, Tutanota: http://bit.ly/34R940L

Calendar spam has been in the news lately (Aug 2019).

Oh snap, Gmail didn’t make the top 5 of email solutions focused on privacy. Oh
well, maybe next year. ;-)
https://youtu.be/oPwrodxghrw — Missed it by that much
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Gmail Settings to stop
calendar spam

= Settings > Event Settings
* View Options

* Events from Gmail

*  htpi//bit.ly/350Lw9Y

General
Language and region
Time zone
World clock
Event settings
View options
Events from Gmall
Keyboard shorteuts

Add calendar

Import & export

Settings for my calendars

Presented at Secure Delaware 2019

Event

Def on
60 minutes

[ Speedy meetings

ack de

ow invitations to which | have respand.

"
De:
" ) Flaynotification sounds
O

] Automatically add video calls to evenis | create

View options
[ Show weekends
[ Show week numbers

Raduce the bightness of past events

Vieaw calandars side by side in Day View

Start week on
Sunday

Set custars e
Adays
anerate cajendass
None

Events from Gmail

] [ automaticaly i svents from Gmai 1y calendr

Image: David Rhoades

Instructions: http://bit.ly/350Lw9Y

Outlook Settings to stop
calendar spam

ﬁn Outlook under File > Options

File > Options

Then follow steps shown to right.

htep://bit.ly/340Q 1 Gmn

General 3
Mail 4 ne: | (UTC-05:00) Eastern Time (US & Canads) i
e L@ [] Show a secong time zone

People Lobel

Tasks Time zone -
Search [ Show a third time zone

Language

Ease of Access

Advanced

Customize Ribbon

Quick Access Teolbarl

Automatically decline meeting requests that conflict with an &xisting appaintment or meeting

Add-ins

Trust Center

Automatically accept meeting requ

Automatically degline recurring meeting requests

accept o

5t5 and remove canceled meetings

™

‘ﬂ“‘- Automatically sccept or decline meeting requests.

Weather

3. [ Show weather on the calendar

O

Show temperature in:

e Em Accept/Decline... |

Celsius

Eobeanbait

oK | [ Conca |
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Image: David Rhoades
Instructions: http://bit.ly/34Q1Gmn

;--have i been pwned?
Monitor for breach data leaks

* Free: Check if you have an account that has been compromised in a data breach —
https://haveibeenpwned.com/

* Subscribe to updates
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Virtual
Private
Network

“The Internet is a series of

tubes!!” — Senator Stevenson

Series of tubes - Wikipedia — https://en.wikipedia.org/wiki/Series_of _tubes

VPN —Virtual Private Network

* Your own private tube.

* Pipes all your traffic (e.g. DNS) from the weakest location (your LAN/WVi-Fi) to another
location before dumping it out onto the Internet.
* Adds integrity and confidentiality to non-encrypted traffic (e.g. DNS)

= Enhances your privacy by hiding your IP address (i.e. ~ geo-location)

* Objection: | don’t need a VPN because...reasons.

© Maven Security Consulting Inc.
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Myth — Private Mode Browsing

* Claim:You are using a web browser in Incognito/Private mode. So now your anonymous,
right?

* Busted:There are various ways to fingerprint and identify you while you're in “private”
more [note the “air” quotes]

* Your source IP address is also being tracked, correlated, and sold. https://clearbit.com/reveal

* Various browser “features” can be leveraged to track you (besides cookies)

* [more details under Browser section]

Your IP history for sale (sort of):

Clearbit knows your business.. literally

T o ,"company” :
,"legalName i
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This is from my home office IP, which does change periodically. Yet Clearbit is
still able to find and track me based on my current IP address.

Not only do they know my name, they know my business info.

93 followers on Twitter #HumbleBrag ;-)

Clearbit — Look ma’ cookie-free stalking tracking

LT B ' s MERRLEEE ¢ Based only on my source IP address.
P cleabit  sousons )

Reveal your highest
value website visitors

Winning hearts and minds...not! #Creepy
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Clearbit — Fun with VPNs

Visiting https ficlearbd.comireveal via VPN where the source IP address is shared and re-used by
(others.. 50 Clearoit thinks this is me at the moment,

* See who used your VPN IP address

recently.
Reveal your highest
value website visitors

Myth — HTTPS

* Claim: | use HTTPS for everything so I'm fine, right?

* Busted: Nope. Sensitive traffic is not always encrypted
* Are you sure your email is encrypted in transit?

* DNS is not (currently) encrypted = privacy and integrity (spoofing) risks
= Evil twin (wireless networks) - Wikipedia —

https://en.m.wikipedia.org/wiki/Evil_twin_(wireless_networks)

* Besides it only takes one piece of non-https CDN content on a site to spoil the whole thing

© Maven Security Consulting Inc. 16| Page
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Myth —“Secure” public Wi-Fi is secure

* Claim: It’s like...network segmentation...encrypted...unique initialization vector
(IV)...like aVLAN

* Seriously?

* Busted: Common tools (Wireshark) if they observe your wireless handshake can then

decrypt all your traffic...

* ...unless you are using transport encryption (HTTPS, SSH, SFTP) or aVPN.

Pop Quiz - Name the two types of wireless networks

Answer: Bad (most “encrypted” ones) and worse (open; no encryption)
HowToDecrypt802.11 - The Wireshark Wiki —
https://wiki.wireshark.org/HowToDecrypt802.11

Wireshark can be configured to observe a Wi-Fi handshake and then decrypt
subsequent traffic.

To capture a four-way WPA handshake the attacker will have to temporarily de-
authenticate the victim from the wireless network. That's easy, and left as an
exercise for the reader. ©

Only traffic with transport-layer security (e.g. HTTPS, SSH, SFTP) are safe at this
point.

A VPN can help protect you against this situation when using public (or private)
Wi-Fi.
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il T-Mobile T THIPM € 100% (6 ¢

< settings Wi-Fi

WiFi @
’ [0 T a= (0
tl;dr —VPN FTW!
CHOOSE A NETWORK.
1" .mai Guest a= ()
Fa.m a = ()
= Features to look for: L 8=
* VPN kill switch e — i)
xfinitywifi P,
* VPN on Demand (VPoD) SR e, T
* No logging policy by company VPR'Sdds comforting

: AL message
* Company outside of 5 eyes jurisdiction? ;

Ask to Join Networks
* Products to consider

* Private Internet Access (PIA) - https://www.privateinternetaccess.com/

* The 8 Best VPN Service Providers of 2019 —
https://www.lifewire.com/best-vpn-service-providers-4061659

A VPN kill switch (or Internet kill switch) is a feature where the device will not pass

traffic if the VPN is not present. This presents the user from accidentally exposing
insecure traffic.

VPN on Demand (VPod) is a feature that enables the VPN connection
whenever there is a request for traffic.

Traditionally, neither of these were an option for typical VPN settings on an
iIPhone. The user had to manually start the VPN (via several clicks into the
device Settings). In addition, the device would happily continue to pass traffic
even after the VPN crashed. Often the user would not notice the small [VPN]
icon along the top edge of their screen had disappeared until after their traffic
had been exposed across the network with the additional protection provided
by a VPN.

Now, several VPN providers offer these features, even for iPhones.
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! T-Mebile 3:40 PM ol 0%

£ Wi-Fi 1 @ 1.8 =-Guest

Forget This Network

M ore Wi_ Fi TiPS le-plsal!y_ turn it off
(s )
* Wire your devices were possible (e.g. * Windows OS:
printer). + treat all new networks as Public

. 5 so you don't share resources
* Turn off wireless access on wired (soy )

devices (e.g. printers). * Settings > "Allow Remote Access" is off

for Public networks
* Don’t auto-join (public) wireless.

* More later about a simple DIY network
5 All Apps Documents Email Web More
segmentation VLAN

Best match

Lz Allow remote access to your
- computer

Cantrol panel

The fewer wireless access points means less interference from overlapping
channels and better bandwidth.

Auto-joining wireless. | prefer manually joining specific networks as needed. I'm
less likely to get punked by an evil twin impersonating a popular SSID (e.g.
xfinitywifi).

If you don’t use “Remote Access” then it’s off. But if you do use it (while on a
secure network of course) then turn it off when you travel.

Settings > "Allow Remote Access" is off for Public networks, or simply off when
you are outside your office (assuming you use Remote Desktop to connect to
that system)

Evil twin (wireless networks) - Wikipedia —
https://en.wikipedia.org/wiki/Evil_twin_(wireless_networks)
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USB Devices

Duckies, and Bunnies, and Sharks, ch my!

Pop quiz:Why do
you think “USB”
devices are
dangerous!?

© Maven Security Consulting Inc. 20 Page
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Reasons to fear USB devices — Malware

* Malware

* Stuxnet delivered to Iranian nuclear plant on thumb drive - CNET — https://cnet.co/2IM|zleZ
* Ploutus-D Malware turns ATMs into loT Devices — http://bit.ly/2LYpHIA

* |IBM warns of malware on USB drives shipped to customers | ZDNet —
https://zd.net/2M| zpkI

* Physical Damage

* But wait, there more... in two slides.

Stuxnet delivered to Iranian nuclear plant on thumb drive - CNET —

https://www.cnet.com/news/stuxnet-delivered-to-iranian-nuclear-plant-on-
thumb-drive/

Ploutus-D Malware turns ATMs into loT Devices —
https://www.zingbox.com/blog/ploutus-d-malware-turns-atms-into-iot-devices/
IBM warns of malware on USB drives shipped to customers | ZDNet —

https://www.zdnet.com/article/ibm-warns-of-malware-on-usb-drives-shipped-to-
customers/

© Maven Security Consulting Inc. 21| Page
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REASONS TO FEAR USB DEVICES
—VOLTAGE...(OR IS IT THE AMPS

THAT GET YOU?)

Presented at Secure Delaware 2019

F USB KILL

* Plugitin

* It charges internal

capacitors...

* Then discharges quickly...

* Result: magic smoke gets out.

Back to schoal: 10% Sale on USBKIll, 25% sale on NFCKill! end novembes

FICIAL USBKILL.COM

ROKIT V3

fMOUS + STANDARD EDITIONS

VOLTAGE DEFENSE — USB
“FIREWALL™?

* robertfisk/USG Wiki —
https://github.com/robertfisk/USG/wiki

Your computer

] § —

.

© Maven Security Consulting Inc.
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This defense is only for the most sensitive systems, such as ones that are typically
air-gapped maybe.

USB devices — it's worse than you think

Threat: USB thumb “drive” is also a remote keyboard (or network card)
Opens command prompt
Starts hacking your system;

Enables remote access

Arctack hardware for sale:

I'm not sure if it is obvious why USB devices are so dangerous. If you think it's
because it might have malware you'd be seriously underestimating the danger.
What if the "storage" device suddenly changes configuration and acts like a
keyboard? Allowing a storage device to act like a keyboards is a serious threat
that is not typically considered. Most people are worried about malware, but
you likely have AV protection against that. However, a rogue USB device (like a
Rubber Ducky https://shop.hak5.org/products/usb-rubber-ducky-deluxe) can
suddenly act like a keyboard, open a command prompt, and start entering the
commands needed to download and install whatever it wants. Complete,
remote, automated PC take over. Just plug it in and walk away. Talk about a
ghost in the machine.

© Maven Security Consulting Inc. 23| Page
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Free USB Defense for PCs

ting system reports a new keyboard:

* Some AV products have USB protection

features. & HID Keyboard Device
This tool protects your PC against malicious devices that
* Free Windows software: e o
G data USB Keyboard Guard
https://www.gdatasoftware.com/en-usb- e e

this device on any PC that is not being protected by G DATA
USB KEVBOARD GUARD!

keyboard-guard

How would you like to continue?

Allow keyboard Block keyboard

Learn mare about this topic...

Here's a free app | use that effectively acts like a USB firewall, prompting the user
if a USB device suddenly wants to be a keyboard (rather than simply
storage):https://www.gdatasoftware.com/en-usb-keyboard-guard

The app is called "G Data USB Keyboard Guard". So, the next time you're giving
a presentation, and someone hands you the USB dongle for the wireless
presentation remote, this app will ensure the "mouse” stays a mouse.

BTW most presentation remotes include a wireless USB dongle that includes
drivers for both a mouse and a keyboard, so don't freak out when this app pops
up a warning. It's not Logitech trying to hack you :-) it's just cheaper to build
these USB dongles with multiple drivers installed. With this app you can block the
keyboard part and use it as a mouse.

© Maven Security Consulting Inc. 24| Page
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OTHER USB DEFENSES TO
CONSIDER

* Your AV might have USB defenses

* USB Type-C Authentication is coming

* Auto-lock your idle PCs

* Disable unused ports (in OS and/or BIOS)

Don't forget to auto-lock your idle PCs, and disable ports on computers that
don't need them. Otherwise, someone might use a USB drive to exfiltrate data
out of your network via sneaker net. Or worse, use a Bash Bunny
(https://shop.hak5.org/products/bash-bunny) to plugin in the next gen of rouge
USB, emulate a network card, and perform attacks on the PC that was
supposed to be air-gapped off the network.

© Maven Security Consulting Inc. 25| Page
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USB Type-C Authentication

* “...enable host systems to confirm the authenticity of a USB device or USB charger...
This protects against potential damage from non-compliant USB chargers and the risks
from maliciously embedded hardware or software in devices attempting to exploit a
USB connection.”

* DigiCert Selected by USB-IF to Operate Managed PKI for USB Type-C™ Authentication -
DigiCert — http://bit.ly/2MaBaMb

DigiCert Selected by USB-IF to Operate Managed PKI for USB Type-C™
Authentication - DigiCert — https://www.digicert.com/news/digicert-selected-
to-operate-managed-pki-for-usb-type-ctm-authentication/
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Anti-Virus

Resource: Independent AV Reviews

* AV-TEST | Antivirus & Security Software & AntiMalware Reviews — https://www.av-
test.org/en/

= AV-Comparatives “...an independent organization offering systematic testing that checks
whether security software, such as PC/Mac-based antivirus products and mobile security

soluticons, lives up to its promises.“ — https://www.av-comparatives.org/about-us/
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VirusTotal

* Which AV to use? All of the above! * Tip: Use VirusTotal on all downloads and

* https://www.virustotal.com/ email attachments.

* Well, not sensitive documents and
proprietary stuff.
* | highly recommend the desktop
install for Windows, Mac OS, or Linux.

Send To »| 1, Compressed (zipped) Folder

* Windows version adds right-click ease cut - g“"""“"“"“"""‘m
¢ i ocuments
of use. e ) Mail Recipient
Create Shortcut & Skype
+ There are 3" party versions too. Delete bl VirusTotal

Rename DVD RW Drive (D:)

The desktop companion app is highly recommended because if it is not simple
to send files to VirusTotal then you are not likely to use it. You want to get in the
habit of sending all your downloads and email attachments. Your desktop AV is
not as good as all of the industry’s leading AVs.

You can find desktop companions for VirusTotal under the 9-dot logo in the
upper-right corner of the site. Final URL is currently:

Desktop Apps — VirusTotal — https://support.virustotal.com/hc/en-
us/articles/115002179065-Desktop-apps

As of Oct 2017 VirusTotal discontinued support for the official Windows uploader.
However, it still works, and there is an open source alternative at
https://github.com/SamuelTulach/VirusTotalUploader

One caveat about the official (but discontinued) version: it may say that your
file is too large to upload. In that case surf to https://www.virustotal.com/ and
try uploading it there, because the web interface handles larger files (500 MB)
compared to the Windows app (128 MB).

© Maven Security Consulting Inc. 28| Page
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VIRUS TOTAL — SET IT AND
FORGET IT WITH
BROWSER EXTENSION

Scan with VirusTotal before downloading?

= See htip://bit.ly/34Z8fmz for official 3] vizia
browser extensions 1 Sean dounloads with ViusTotl Soncel
e f, ste.) with VirusTotal
= VTZilla - Firefox extension is the best R A
option - automatically (with A o o
confirmation prompt) scan each ) Send anonymoss passive DIS data to VisTotat
download 3] vizila
= Confirmation prompt allows you Fila sanit sucsonsolly
to avoid sending sensitive ot URL report
downloads File report

* Desktop app still useful for email
attachments

Level up beyond VirusTotal

* Free Automated Malware Analysis
Service —
https://www.hybrid-analysis.com/

EL-peeey

* For advanced cases; can optionally call
VirusTotal = e

EAEnable ¢

Route the TCP based traffic (HTTR/S, DNS, TLS,
[IAllow Ing et via TOR to avoid e.g. external P fingersrintig

[ 1Route Network Traffic via TOR @ (opticnal)
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Sample at https://www.hybrid-
analysis.com/sample/48beacc7b905dcbdcf992fefld62alecl1484c295db469ad
b2a7877ac58d2ea7e

Screenshot shows there was JavaScript running from PDF.

https://www.hybrid-
analysis.com/sample/2818078484ec60ad7510106fdef02bf6b557a56c8381328232
51580b5bfdel1b/5d840f8d028838d368acl7a6

Shows the PDF had web beacon in it making outbound connection to another
site.

Better browser

© Maven Security Consulting Inc. 30 Page
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Get a better browser

* Better browser * Self-Audit security -
+ Top pick: Firefox https://browseraudit.com/

https://www.mozilla.org/en-US/firefox/

= Self-Audit privacy -
* BrowserlLeaks — https://browserleaks.com/
* Panopticlick — https://panopticlick.eff.org/

* Privacy oriented mission...not driven by
tracking you for ad revenue.

* Better search

* DuckDuckGo https://duckduckgo.com/
* How to Live Without Google —
https://spreadprivacy.com/how-to-remove-

google/

BrowserAudit checks that your web browser correctly implements a wide variety
of security standards and features.

BrowserLeaks.com - Web Browser Security Checklist for Identity Theft Protection
* WebGL Fingerprinting

* HTML5 Canvas fingerprinting

* Font metric-based fingerprinting

* |P address / VPN detection
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BrowserAudit checks that your web browser correctly
implements a wide variety of security standards and features.

Firefox | Ghvome

BrowserAudit BrowserAudit

381 3 0 20 373 10 1 20

Quick test of Firefox vs. Chrome via BrowserAudit, which checks that your web

browser correctly implements a wide variety of security standards and features.
BrowserAudit — https://browseraudit.com/
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Security Test your Browser

¢ https://browsercheck.qualys.com/

@ Qualys. BROWSERCHECK

* Quick check without plugln oo

ACME Corp.

* More thorough with the plugin

* https://www.qualys.com/free-tools-
trials/browsercheck/

* Personal (above)

* Business (dashboard of all browsers)

BROWSERCHECK
PLUGIN

* But wait, there’s

Add Qualys BrowserCheck for Windows?
more... It requires your permission to:

data for sites in the qualys.com domain

* Remember — every your data for broy heck.g

r data for browsercheck ga.qualys.com

o e sag ith programs other than Firef
piece of software S e s @ Trmcsoutoinstting e s

BrowserCheck Browser Extension.

increases your attack
surface.

Cancel

complceed ta biegin the sean

= Cost vs. Benefit
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Remember — Trust but verify

|>

2 a24dd5fe442addcbafe4bf3121ca2d24904ec8d9ced03cd3a25b4329e9f3e20 Q

(@) No engines detested this file
a2dddsf6ad 1210a2d2490: 030d3a25fba3 2.06 MB 2019-09-18 20:57:48 UTC

=
20

qualys-browsercheck-1.10.44.1.msi

msi signed
"
S
DETECTION DETAILS COMMUNITY
Ad-Aware () Undetected AegisLab () Undetected
AhnLab-V3 (%) Undetected AlYac (/) Undetected

Remember to test all your non-sensitive downloads with VirusTotal.
Don’t send them your payroll PDF reports. ©

Enhance your privacy while browsing — Blocking trackers

* TunnelBear Blocker — https://www.tunnelbear.com/apps/blocker

* Privacy Badger | Electronic Frontier Foundation — https://www.eff.org/privacybadger

* It's worse than you think: Social buttons everywhere
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“What are social buttons?

Social buttons are widgets embedded within websites that allow users on web
pages to “Like”, “Tweet”, and share those pages via social media. Whether or
not you press these buttons or are a member of these services, they relay your
browsing patterns back to those organizations. Many people would prefer if
social media companies and advertisers did not have a profile of their website
browsing.

What's an example?

A user planning a surprise trip for his partner is browsing vacation resort websites,
most of which feature social buttons. Despite not clicking on any of these
buttons, targeted ads for these resorts and flight deals appear on future third-
party web pages visited by his browser, and also start popping up on his
Facebook timeline for the next week. This kind of tracking can feel pretty
invasive, hard to evade, and stressful concerning the risk of the user’s partner
finding out about his plans. “

Source: https://www.tunnelbear.com/blocker/info

ENHANCE YOUR PRIVACY
WHILE SEARCHING —
ESCAPE THE BUBBLE

* Switch to DuckDuckGo — better

results; better privacy
https://duckduckgo.com

¢ Don't Track Us! - By
DuckDuckGo —

https://donttrack.us/ Ta ke b a C k yo u r p rlva Cy!

Switch to the search engine that doesn't track you.

Filter bubble - Wikipedia — https://en.wikipedia.org/wiki/Filter_bubble
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Filter bubble — a state of intellectual isolation

Small Business

websites - HTTPS
* Non-HTTPs is a bad look (at best) ce r tb Ot

Confidentiality — Eavesdropping,
even on encrypted VWi-Fi is easy.

* Integrity - MITM attacker can inject n Let’s Encrypt

malicious content

E ELECTRONIC F F
* Free - https://certbot.eff.org/ FRONTIER
FOUNDATION

Certbot is a free, open source software tool for automatically using Let’s Encrypt

certificates on manually-administrated websites to enable HTTPS.

Certbot is made by the Electronic Frontier Foundation (EFF), a 501(c)3 nonprofit
based in San Francisco, CA, that defends digital privacy, free speech, and
innovation.
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Company Email

Email spoofing defense (DMARC with SPF and DKIM)
https://dmarc.org/overview/

Free DMARC monitoring service -
https://dmarc.postmarkapp.com/

Test how spammy your emails look —
https://www.mail-tester.com/

DKIM is a method to validate the authenticity of email messages. When each
email is sent, it is signed using a private key and then validated on the receiving
mail server (or ISP) using a public key that is in DNS. This process verifies that the
message was not altered during transit.

SPF is a way for ISPs (like Gmail, Yahoo, etc) to verify that a mail server is
authorized to send emaiil for a domain. It is a whitelist for the services who are
allowed to send email on your behalf. Like DKIM, SPF also works via DNS.
DMARC (Domain-based Message Authentication, Reporting & Conformance) is
a standard that prevents spammers from using your domain to send email
without your permission — also known as spoofing.

DMARC lets you tell ISPs how you want them to behave if SPF and DKIM fail or
are not present.

Source — https://postmarkapp.com/guides/dmarc

A free tool to monitor & implement DMARC

DMARC is a standard that prevents spammers from using your domain to send
email without your permission — also known as spoofing.

They will process reports from major ISPs about your domain's DMARC alignment
and turn them into human-readable weekly email digests, absolutely free. —
https://dmarc.postmarkapp.com/
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WordPress — Site Health
Check in WP v5.2

* Look under Tools > Site
Health

Presented at Secure Delaware 2019

Site Health Status

T 525 e heck s ] BIEATN 4O 70

1 Critical lssun

Backgroun updates o ot warking 3z supactsd

Sackaromme vg-btes suzare tht Wordiess o st 2

4 Rocommensbed mprovements

You shaul remave nacie Blugin

we reeamn you upaats Pip

ane ov o resorrenended mosales v ising

scaty

iy

Partormanca

THE CASSANDRATOOL -
DIY THREAT
MONITORING (SORT OF)

* For small business (or 1337
home users)

* Get daily email alerts for
tech that matters to you by
vendor, product, or keyword.

* On demand search across a
timespan (e.g. past 3 months)

* Links directly to official
advisories

* Free

Span: 90 days
Sinze 2019.06.21; rodsy 12 2019.00-19

All Products from Specific Vendors

By Product

Office_365 (by vendor: Microsoft)

[CVE-2010-110)]

A 5p00fing vulnerabilty Cxists when Microsot
Office Javaseript does ot check the vaiidty of
tne wed page making a roquest o Gffice
focuments An alfacker who successfully
xplosied this vulnerability could read or write

in Office documents The securiy

NERABILITY DATABASE

AKCVE-2019-1109 Detail

Current Description QUICK INFO

0
the way that Microsaft Office Javascript verifies
usted web pages. aka Microsolt Office
Spoofing Yulnerabiity’

Windows_10 (by vendor: Microsoft)

CVE-2010.0714]

hicrasoft Hyper- Network Switch on a host
scrver fails 1o properly validate input from a
privileged user on a guest operating syste,

CVE2010.0715| S

aka Windows Hyper-V Denial of Service
Vaulneratbilty This CVE I0 is unique from
CVE-2019.0715, CVE-2019-0717,
cVE.20 CVE.2019.0723

ics vulnerabillly exisis when
jcros etwork Switch on & host
server falls Io properly validate inpul from a
privileged user on a guest operafing system,
"Windows Hyper-V Denial of Serviee:
Vulnerabilty This CVE ID is unique from

[ denial of service vulnerabilty exists when

Searches

All entries
1 vear
3 months
this month
>mental(Shows new vulnerabilities since last
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The Cassandra Tool

This tool simplifies keeping up-to-date with vulnerabilities in the National
Vulnerability Database (NVD, formerly ICAT) or Secunia databases. Instead of
going to these sites every day and repeating your searches, Cassandra does the
work for you (even twice a day for Secunia). It works by saving lists of products,
vendors and keywords into "profiles". Whenever new information is available,
Cassandra can notify you by email. You can create as many profiles as you
want, for networks, typical installs, important hosts, or simply areas of interest to
you. The important thing is that you should get emails only for things that are
relevant to you, so you don't have to scan every message on various mailing
lists. — https://cassandra.cerias.purdue.edu/main/index.html

PHISHING

* Free Phishing Security 1Q Test by PhishingBox —
https://www.phishingbox.com/phishing-test

+ PhishMe Free | Simulated Phishing Training —
https://cofense.com/free/

* Includes training and testing

» Top 9 Phishing Simulators [Updated 2019] —

https://resources.infosecinstitute.com/top-9-free-phishing-simulators/
* A bit more DIY if you have IT staff
(or simply someone that has a penchant for wearing hoodies)
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Training Resources

#GetWoke

Security Awareness Training Resources

* For your company: PagerDuty Security Training — * For you: Free Phishing Security IQ Test by PhishingBox —
hteps://sudo.pagerduty.com/ https://www.phishingbox.com/phishing-test
+  Free; one for everyone and one for engineers...because
their special ;-)

* For your home:Protect Seniors Online | Home Instead
Senior Care — https://www.protectseniorsonline.com/
* For you: Surveillance Self-Defense | Tips, Tools and How- *  Includes a “spot the scam” quiz.
tos for Safer Online Communications —

hteps://ssd.eff.org/en

*  Security Awareness for Kids:Tips for Safe Internet Use —
htep:/bit.ly/2M7h2KR
*  For business: CBFree - Cofense — +  For kids — hteps://www.missingkids.org/NetSmartz
https:/icofense.com/cbfree/
+ Learning management system (LMS) needed
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A good collection of various resources, and a decent primer for parents.
Security Awareness for Kids: Tips for Safe Internet Use —
https://resources.infosecinstitute.com/security-awareness-kids-tips-safe-internet-
use/
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Event: Secure Delaware 2019 Workshop

* What: cyber security training for * Related List of Events:
Delaware's citizens, business employees, Cyber Security in Delaware —
students, and government employees. https://digiknow.dti.delaware.gov/pages/c
* When:Tuesday, Sept 24,2019 ybersecurityevents.shtml

* Where:Wilmington, DE 19801
* Various events throughout the year for
seniors, kids, small businesses...

* Cost: Free

« SOLD OUT ® orisit? | can'ttell -
http://bit.ly/2LXsRD6

Event: Delaware Infragard

* What: Voter Fraud and Election Security

* When: Wednesday, October 2,2019 from 8:00 AM to 12:00 PM (EDT)
* Where:Wilmington University, New Castle, DE

* Cost: Free

* See all their events here: http://bit.ly/2M350ch
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EVENT: BSIDES DELAWARE
2019

* What: Talks, workshops, CTF, lockpicking village, Wi-Fi
CTF, Spawn Camp (for kids)

* Where: Newark, DE 19713

* When: November 8-9,2019 es.\n.m,...
* Cost:$12 ( - S’DES *

* Notable: Kid-friendly hacker con. ©

2019

* http://www.bsidesdelaware.com/

EVENT:WOPR
2020

* What: WOPR Summit is an
immersive hacking conference
focused on hardware, software, and
wireless technologies.

* Where: Fort Washington, PA
19034

* When: March 27th-29th, 2020
* Cost: $40-$100

* https://www.woprsummit.org/
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Misc.Tips

Authentication

* For critical accounts insist on MFA/2FA that is not SMS.

* Do not use the same (or similar) password for multiple sites

* Use a password manager to keep track of a long random unique password for every site.
* Leverage browser password manager on trusted system.

* Poll:What types of accounts are most critical to you?

* Banking, social media, ...
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SMS 2FA gave us sweet FA security, says Reddit: Hackers stole database backup
of user account info, posts, messages ¢ The Register —
https://www.theregister.co.uk/2018/08/01/reddit_hacked_sms_2fa/
Twitter Suspends SMS-Based Tweeting After High-Profile Account Hacks —
https://www.bleepingcomputer.com/news/security/twitter-suspends-sms-based-
tweeting-after-high-profile-account-hacks/
| would say the most critical accounts | have are:

- Business and personal banking accounts

- Domain name registrar

- Emaill (#1 concern because it is the key to getting access to so many

other accounts via “account reset” procedures).

It's Time to Stop Using SMS and 2FA Apps for Two-Factor Authentication —
https://www.makeuseof.com/tag/two-factor-authentication-sms-apps/
Types of two-factor authentication, pros and cons: SMS, authenticator apps,
YubiKey | Kaspersky official blog — https://www.kaspersky.com/blog/2fa-
practical-guide/24219/

Account Recovery

* Answers to account recovery questions should not be real answers.
* Q:What is the name of your first pet?
= A: CQISICFEZ%QoCHqY

* Use a password manager to store them.
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Money, Money, Money

* On-demand, single-vendor use credit cards

* Token -Virtual, Secure, Anti-Fraud Payment Cards — https://jointoken.com/#/

* Privacy - A better way to pay.— https://privacy.com/
* [Author note — I;ve not used this but was told about it.]

* Extension puts a convenient button in the card field at checkout, so all you have to do is click.

* Enable transaction notification (push or SMS) for credit card purchases and bank

transactions.

IOT

* If possible use network
segmentation

* Research the vendor’s track
record for posting firmware
updates.

* Look for independent security
testing/research:

* Internet of Things | AV-TEST —
https://www.av-test.org/en/internet-of-

things/
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Random Tips for Parents/Guardians

* Netflix — parental controls at https://www.netflix.com/pin
+ “Restrict Specific Titles” regardless of rating.

* Gaming: Nintendo Switch — good parental controls via official mobile app

* Parental control products reviewed here: http:/bit.ly/340fy0 |

* Qustodio.com — monitor all the things...even works on Kindle?!?
* But no Chromebooks — doh!

* https://www.qustodio.com/en/

Test: Parental Control Software for Desktops with Windows 10 & MacOS | AV-
TEST — https://www.av-test.org/en/news/test-parental-control-software-for-
desktops-with-windows-10-macos/
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Further Resources

* Krebs on Security — https://krebsonsecurity.com/

* Great news storied and some original investigative work

Bonus — Let’s rant about school issued IT devices

* CTRL + Hin browser to see
history...each day ®

* But you need physical access ® because G
Suite for Education does not include online
access to all the browsing history...that’s a
paid feature not in Education version. ®

* You can see some history for G Suite
accounts online; but only Google
properties (includes YouTube)
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Closing Summary

But first, let’s take some questions

Summary of Next Steps

* Understand your specific risks * Switch to Firefox and DuckDuckGo for

- Segment your wireless network via “guest better privacy; with tracking blocker

network” * Do not re-use a password; Use a password

manager
* Make everyone use a “Standard” user on i

Windows * Add 2FA/MFA to critical accounts

« VPN when using puincWi-Fi * Avoid SMS 2FA where possible

* USB protection
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CONTACT INFO

+ Submit feedback

= A copy of this presentation can be found at
https://MavenSecurity.com/resources

* David Rhoades

. SECURITY CONSULTING
= (@MavenSecurity
+ david.rhoades @ mavensecurity.com

« +1-877-MAVEN-HQ (1-877-628-3647)

Author Contact Information

| hope you found this useful.

Remember, with great power comes great responsibility.
Please submit feedback via the event, or send it directly to me.
We can be reached at +1-877-MAVEN-HQ (1-877-628-3647)
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Copyright & Attribution

Presentation is © Maven Security Consulting, Inc

Image sources are listed in the notes page of relevant

slide, where attribution is required.

Non-attributed images are from one of these sources:
https://pixabay.com/service/license/

https:.//www.pexels.com/photo-license/
Licensed but attribution in this context not required.
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